
 

 
 

Keyboard shortcuts in Windows 
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This sheet contains keyboard alternatives for Windows 95 and above.  If you 
are using Windows 3.1 or 3.11 ask us for the factsheet entitled "Keyboards: 
an Alternative to the Mouse". 
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Section 1 - Introduction 
 
1.1 Introduction to our keyboard 
When we first get a computer with a graphical user interface (GUI), like 
Windows, our computer acquires a mouse.  We become used to moving the 
pointer and clicking on what we want.  When we get competent with our 
mouse, we rarely think of using the computer in any other way.  After all that's 
what the mouse is for, isn't it?  But it's not the only way to get what we want 
from our computer.  It's often not the easiest way either!  For some people the 
mouse can be frustrating, uncomfortable, even painful, and for others a visual 
impairment may mean that use of the mouse isn't an option.  The keyboard is 
not just the standard input device, it is a powerful and effective tool that can 
replace the mouse completely.  
 
An instance of when using the keyboard is easier and more efficient than 
using the mouse might be, for example, when you want to get to some of the 
controls situated on your Desktop (see section 3.1) and hence need to clear 
away from cluttering the screen all running programs that are open.  This 
would take many mouse movements and clicks to clear from the screen each 
program one by one.  But by simply pressing the Windows Logo key (situated 
between the left Ctrl and Alt keys)+M clears away all running programs in one 
fell swoop.  
 
A note of caution:  Whereas it is possible to do everything in Windows itself 
from the keyboard, some programs that you might have on your computer 
may not altogether adhere to the guidelines set out for keyboard alternative 
conventions.  You will find, however, that your Windows programs will feel 
reassuringly similar when being controlled from the keyboard. 
 
1.2 Keyboarding difficulties 
If you experience any difficulties in using the keyboard, either because you 
hold your finger down too long on a key and get a string of characters on the 
screen, because you brush other keys by mistake, because your hands shake 
or because you can only press one key at a time, there are ways of tuning 
your keyboard to tailor its response to your particular requirements.  
 
For an explanation of these functions contact us and ask for the factsheet 
entitled "Accessibility Options in Windows". 
 
If you think a different keyboard might help ask us for the "Getting Round 
Difficulties with the Keyboard and Mouse" factsheet. 
 
Now let's see how easy it is to operate Windows using the keyboard by 
following the examples overleaf.  
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Section 2 - examples to follow 
 
Before we start outlining the keystrokes available to you in Windows, why not 
follow these examples which will give you an idea of what it is all about? 
 
 
2.1 Example 1:  Open Notepad, create and save a document. 
 
Let's write a small document in Notepad and then save it under a filename.   
 

1. Pull up the Start Menu by pressing the Windows logo key (between the 
left Ctrl and Alt keys or to the right of the right Alt key). 

 
2. Now hit P to select the "Programs" option.  This drops down a sub-

menu of all your programs. 
 

3. Now hit A until "Accessories" is highlighted.  If the sub-menu for 
"Accessories" has not already dropped down then hit Enter or Right 
Arrow to open it. 

 
4. Now Hit N.  If Notepad is the only program in your Accessories 

beginning with this letter then Notepad will now open, otherwise keep 
pressing N until Notepad is highlighted and press Enter 

 
Now type the following text into Notepad as follows: 
 
Exercise one 
 
No danger of becoming a "mouse-potato" when you learn how to 
operate Windows the easy way - from the keyboard! 
 

1. Now hold down the left Alt key and press F to pull down the File menu. 
 

2. Press S to select the "Save" option and the "Save As" dialog pops up. 
 

3. Now type in the filename "exercise one" (without the quotes) and press 
Enter. 

 
You have now written and saved a document 
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2.2 Example 2:  Open WordPad and paste some text from Notepad 
 

1. Leaving Notepad open, repeat the process used to open Notepad by 
pulling up the Start menu and selecting "Accessories", but press W 
instead of N to select and open WordPad. 

 
2. Now switch to Notepad by holding down the alt key and pressing Tab 

once. 
 

3. Now highlight all the text in Notepad.  This is done by pulling down the 
Edit menu with Alt and E, then press A to choose "Select All". 

 
4. Copy this text to the Windows Clipboard by holding down Ctrl and 

pressing C. 
 

5. Switch back to WordPad with Alt Tab. 
 

6. Now we will change the appearance of some of the text.   
 

7. Press Ctrl+Home to get to the top of the document. 
 

8. Press Shift+End to highlight the title "Exercise One" and then Ctrl+B to 
make it bold and Ctrl+E to centre it. 

 
9. Now arrow down twice to the first line of text and use Ctrl+Left or Right 

Arrow to jump words at a time until you land on the "m" of "mouse" 
 

10. Now press the Right arrow three times whilst holding down the Ctrl and 
shift keys to select the phrase in quotes. 

 
11. Press Ctrl+I to italicise the text. 

 
12. Now print the document with Ctrl+P and Enter. 

 
13. Then save it with Ctrl+S, followed by giving it a filename and pressing 

Enter 
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Section 3 - Windows keyboard commands 
 
3.1  Navigation without a mouse 
 
Introduction to the desktop 
Depending on your setup preferences several items will appear on the screen 
when you enter Windows.  There will be, by default, the Taskbar located at 
the bottom of your screen and is always visible when Windows is running. 
Every time you start a program or open a window, a picture representing that 
program appears on the Taskbar. When you close a program, its picture 
disappears from the Taskbar.  The Taskbar also includes the Start Button, on 
the left end, and the time, shown at the rightmost end.  The rest of the screen 
contains a number of icons (pictures with a text label beneath) with different 
functions, such as "My Computer", "Recycle Bin" etc. For example the ‘My 
Computer’ icon will take you to a window that lists all your drives, folders and 
files. 
 
These icons are sitting on a background that may be plain or a picture.  This 
area is called your "Desktop" and it is possible to move the highlight, or focus, 
from the Start button to the Taskbar to the icons on the Desktop with the Tab 
key.  Give it a go. 
 
When one of the icons on your Desktop is highlighted you can move between 
them using the Arrow keys, or by typing the first letter of their names.  Select 
the item by pressing Enter.  
 
Similarly, when the focus is on an item on the Taskbar, you can use the Left 
and Right Arrow to move between them and press Enter to go to that running 
program.  But how can we run a program without using the mouse? 
 
Opening programs 
You can get to most programs you have on your computer by simply pressing 
the Windows Logo key (situated between the left Ctrl and Alt keys and to the 
right of the right Alt key).  This pulls up the Start Menu which has several 
items that perform a range of useful functions. 
 
In the Start Menu, like in all other ‘pull-down’ menus, the Up and Down Arrow 
keys will move up or down through the items, and the Right Arrow will open 
any sub-menus. 
 
Also, hitting the first letter of an item will take the highlight to that item, so 
hitting P will open the Programs submenu.  Move through the programs you 
have in your Programs submenu using the arrow keys or by pressing the first 
letter and open a program by hitting Enter. 
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Most Used programs 
Programs that are in the StartUp submenu will be started automatically when 
you start Windows.  Use this to open programs you use often.  This could 
save you mouse movements and keystrokes.  (To add a program into StartUp 
see "Working with files and folders - Copying files and folders" in the Help 
item of the Start menu).  
 
Moving between open programs quickly 
Hold the Alt key down and press the Tab key (Above the Caps Lock on the 
left).  A box appears in the middle of the screen displaying the program that is 
next available to you.  As you keep pressing the Tab key you will cycle 
through the open programs.  When you see the program you want, release 
the keys.  You have now transferred to that program, without minimising the 
initial one.  Pressing Alt Tab once will take you back to the previous program.  
 
Dialog boxes in Windows - general principles 
You are often presented with different boxes (called Dialog Boxes) on screen 
(such as; save as, print, format document etc.).  Getting around these boxes 
is a little different from the rest of Windows.  In some boxes you can pick a 
button or go to an option by pressing the letter that is underlined in its name.  
Some you need to use the Alt key with the letter.  However, some general 
rules do apply.   
 
• Use Tab and Shift+Tab to move forwards and backwards through the 

controls 
• When on a button you can press Space to activate it 
• If the control looks like a slider use the Left and Right Arrows or PgUp and 

PgDn to change the value 
• In a group of options with circles beside them, one of which is filled in, use 

the arrow keys to change the selected option 
• A control that comprises a list of items, one of which is highlighted,  can be 

moved through using the arrow keys 
• If a control comprises an option in a box with a downward pointing arrow 

symbol to the right a drop down list can be opened with Alt+Down Arrow 
• An item with an empty box to the left can be checked or unchecked with 

the Space Bar 
• Cardfile-type tabs along the top of the Dialog Box represents multiple 

pages of options.  Pressing Ctrl+Tab changes which page of options is 
visible. 

 
3.2. Using functions and menus 
 
Menus and menu options 
Most menus will have a single word name.  The name contains a letter that is 
underlined (e.g. File).  By pressing the Alt key (Left of the Space Bar), you will 
activate the menu bar (the box with the small dash at the top left hand corner 
of the screen becomes highlighted). Then by typing the letter that is 
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underlined (F for File), you will call up that menu.  You can also combine the 
Alt and the letter in one keystroke.  This is exactly the same as if you had 
clicked on the menu with the mouse.  Press the letter that is underlined in the 
option you wish to use from that menu, without the Alt key, (e.g. S for Save), 
and that too is selected without the use of the mouse.   
OR:   After selecting the Menu (using Alt+F for file, for example) you can use 
the arrow keys to move down the list of options using enter to select.  By 
using the arrow keys left and right, you can move across to the next menu 
along. 
 
Getting into control menus 
We have had a look at using the Alt key to select a named menu, but there 
are menus that don't have a name (the control menus in the top left corners). 
Alt+Space Bar will select the main control menu.  From here you can close 
the program, or minimise/maximise it. 
OR: 
Sometimes two control menus are live - such as when you are writing a 
document in a word processor.  One (the program) will have a long dash in 
the box, the other (the document) a short dash.  Alt+- (minus sign) will give 
the same for the secondary windows as Alt+Space does for the main 
windows. 
 
Hot keys 
With some Windows software we can use Hot-Keys (including Windows 
itself).  These are combinations of keys (like Ctrl+P), that will perform a 
function (like print), automatically.  Hot-Keys are activated straight from the 
document itself.  You don't have to access a single menu!  By looking inside 
the menu you use to save your work, you may find that a combination of keys 
is printed to the right of that option (e.g. Save  Ctrl+S).  Instead of moving the 
mouse and clicking, or using the Alt key to go through the menus, we can 
save our work automatically by keying Ctrl+S.  Your work is saved in exactly 
the same way as before.  Other regularly used functions can be achieved in a 
similar way.  Often used hot keys are; Ctrl+P for Print, Ctrl+O for Open, Ctrl+N 
for new.  Other hot keys specific to your programs can be found by using the 
help menus (try F1).  
 
Function keys 
At the top of keyboards you will find the Function Keys (F1 to F12).  In most 
major software you will find that certain function keys can be used to do some 
of the more common tasks in one keystroke (like spell checking).  In Microsoft 
Word for example, you press F7 to perform a spell check.  Once inside the 
Spell Check program, you will notice that again certain letters are underlined 
(on the buttons).  By using the Alt key with these letters we can perform the 
whole spell check procedure from the keyboard. 
 
OR:  Another popular hot key is F1 - for Help.  Almost all Windows programs 
come with some sort of help file that can be triggered by using the F1 key.  If 
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you are having trouble with a program, press F1 and look around with the 
arrow and Tab keys, hitting Enter to select an item. 
 
3.3 Text manipulation  

 
Highlighting 
To perform the same function as clicking and dragging on a mouse, hold the 
shift key down and use the arrow keys.  Quicker methods on the same vain 
are; Ctrl+Shift and Left/Right Arrow to highlight a word at a time, Ctrl+Shift 
and Up/Down Arrow to highlight to the beginning/end of the paragraph (from 
the cursor point).  Some programs use a Hot-Key like Ctrl+A to highlight all of 
the text in a document with one keystroke.  By using the PgUp, PgDn, Home 
and End keys to get around, you can quickly highlight the areas you need 
without the use of the mouse. 
 
Cut, copy and paste 
You can cut copy and paste information using the keyboard shortcuts.  You 
can either use them via the Edit menu or, in most Windows programs you can 
use; Ctrl+X for cut, Ctrl+C for copy and Ctrl+V for paste.  Notice that these 
keys are together, for quick use while working.  A good way to remember this 
is to think of Ctrl+C(opy), with cut and paste being either side.   
 
OR:  Another method that works in all Windows programs is; Ctrl+Ins to insert 
data into the clipboard, Shift+Ins to paste.  This method also works for certain 
graphical image manipulation such as when using Paintbrush. 
  
Bold, italic and underline - and delete text 
By using the menu system via the keyboard you can format the type of font 
you wish to use and any enhancements along with it.  Access the Format 
menu in your program and choose the font option.  By Tabbing to the choice 
you wish to change and typing the new value, you can accomplish anything 
available on a toolbar. 
  
Some key saving shortcuts that are supported by most large programs are; 
Ctrl+I for italic, Ctrl+B for bold, Ctrl+U for underline.  (This will only work with 
programs that support this level of character enhancement.)  These key 
combinations can be used as you type, pressing them before and after you 
type the text to be enhanced, or they can be used to enhance an area of text 
you highlighted as above. 
 
You do not have to delete letter by letter or use the cut option if you want to 
delete areas of text.  Highlight, then press the delete key (or backspace).  If 
you wish to delete a few words or just the last word try 
Ctrl+Delete/Backspace.  This will delete text word by word instead of letter by 
letter.   
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3.4 More keyboard commands 
So far we have outlined some of the keystrokes that enable us to operate our 
computer from the keyboard.  Let's start listing in more detail these 
keystrokes, and some other keyboard alternatives.  
 
What can the Windows key do? 
As mentioned in the introduction the addition of the Windows Logo Key to the 
keyboard has given us some useful new keyboard functionality.  Here is a list 
of the most useful keyboard commands: 
 
Key Function 
Windows Logo key or 
Ctrl+Escape key  

Opens the Start Menu located on the 
Task Bar 

Windows Logo key+M Minimises all open applications, taking 
focus to the Desktop 

Shift+Logo key+M Restores all open applications 
Windows Logo key+E Opens the Windows Explorer (also found 

in Start Menu/Programs) 
Windows Logo key+F Opens the 'Find All Files' Dialog Box 

(also in Start Menu) 
Ctrl+Logo key+F Open the 'Find Computer' Dialog Box 
Windows Logo key+R Opens the 'Run' Dialog Box (also in Start 

Menu) 
 
 
Windows Explorer keys 
The Windows Explorer displays and can manipulate the contents of your disk 
drives, folders (directories) and files.  It can be accessed at any time with the 
Windows Logo key+E, or from the Start Menu 'Programs' item. 
 
Usually Windows Explorer displays two panes, the left containing a 'tree-view' 
of the folders on your computer, and the right containing the files contained in 
the currently selected folder. 
 
The directory structure comprises folders branching out from the topmost 
folder, which is 'Desktop' and contains those items visible on your Desktop, 
and can be used as an alternative way of accessing those items.  A folder has 
a 'parent' folder (apart from 'Desktop') and may also have several child 
folders. 
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Here is a list of the keyboard shortcuts for Windows Explorer (many of these 
functions can also be activated from within the pull-down menus) 
 
Key Function 
Up and Down Arrow keys Moves up and down through items 
Any letter key Cycles through items beginning with 

that letter 
Home  Goes to the topmost folder or file 
End Goes to the bottom-most folder or file 
Enter To open a folder or select a file 
Backspace To open the parent folder 
Ctrl+G Opens 'Goto Folder' dialog 
Ctrl+F or F3 Opens 'Find All Files' dialog 
Delete Deletes the highlighted items keeping 

a copy in the Recycle Bin 
Shift+Delete Deletes highlighted items without 

keeping a copy 
Alt+Enter key Displays the properties of the 

selected item 
F2 To rename the highlighted item 
F4  Opens the pull-down list box from the 

Toolbar 
F5 Refreshes the contents of the current 

window 
F6 or Tab key Cycles between the left pane, right 

pane, and the toolbar 
 
(in tree-view (left pane) only) 
Right Arrow Opens any child folders and highlights 

the first 
Left Arrow Closes child folders or highlights the 

parent folder 
Numpad * Expands everything under the current 

folder 
Numpad - Closes everything under the current 

folder 
Numpad + Expands everything below the current 

folder 
 
To copy or move the highlighted files or folders use the Copy or Cut keyboard 
shortcuts (Ctrl+C, Ctrl+X), then Paste (Ctrl+V) them elsewhere. 
 
Hot-keying your favourite programs 
Creating hot-keys is an easy and quick way of opening, or switching to those 
already open, programs and documents you use most often.  You can put a 
Shortcut as an icon on your Desktop or as an item on your Start Menu, and as 
a Keyboard Shortcut comprising a combination of the Ctrl, Alt, Shift and any of 
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the letter or number keys.  To assign a Keyboard Shortcut, there must also be 
either an icon on the desktop or an item on the Start Menu.  
 
To create a Shortcut and place it on your Start Menu: 
 

1. Open the Windows Explorer with Windows Logo key + E or by 
selecting it from the "Windows Explorer" option in the "Programs" sub-
menu found in the Start Menu. 

2. Open the folder in which the desired program or document is situated. 
3. Highlight the desired program or document. 
4. Open the File Menu with Alt + F, and press the letter S to create a 

Shortcut for the highlighted item.  An extra item "Shortcut to ..." will 
appear in the right pane. 

5. Highlight this new Shortcut item in the right pane 
6. If you would like to rename this item before placing it on the Start Menu 

then press Alt + F to pull down the File Menu, and then the letter M for 
"Rename".  Now type the new name and press the Enter key. 

7. Use the Copy command (Ctrl + C) to copy the highlighted item to the 
clipboard. 

8. Press Alt + F4 to close Windows Explorer. 
9. Open the Start Menu with Ctrl + Escape key, or the Windows Logo key. 
10. Press the Escape key to close the Start Menu and leave the focus on 

the Start Button. 
11. Press Shift + F10 to open the Shortcut Menu for the Start Button. 
12. Press the letter E to select the "Explore" item which opens another 

copy of Windows Explorer with the contents of the Start Menu in the 
right pane. 

13. Use the Paste command (Ctrl + V) to paste the new Shortcut to the end 
of the list of Start Menu items. 

14. Press Alt + F4 to close Windows Explorer. 
 
To assign a Shortcut key to the Shortcut: 
 

1. Highlight the Shortcut on the Desktop or, if in the Start Menu, the 
equivalent item in Windows Explorer. 

2. Press Alt + Enter key to open the Properties dialog. 
3. Press Ctrl + Tab key to display the Shortcut page. 
4. Press Alt + K or Tab key to move to the Shortcut key edit box. 
5. Press and release your desired key combination including any of the 

Ctrl, Alt and Shift keys.  Press Backspace if incorrectly entered. 
6. Tab once. 
7. Press the Enter key to select the "OK" button. 
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Section 4 - Conclusions 
 
4.1 Things we can't do with a keyboard 
We have seen how the mouse can be replaced in a lot of areas by simple 
keystrokes.  But remember the mouse is a powerful tool in its own right, and if 
used with the keyboard they complement each other.  Some things for some 
users are quicker done with a mouse.  Try drawing a curved line with a 
keyboard!  All modern programs allow the user to drag information from one 
place to another with the mouse.  There is no keyboard alternative for this 
feature - to date.     
 
The keyboard can be used on its own for 95% of the time you use a computer.  
The other 5% if necessary (most users would not be doing drawing for 
example), can be accessed via the keyboard given the right adaptive 
software.  If you cannot use, or do not want to use a mouse, you can still use 
a computer with Windows, via the keyboard, to do all your work.  A keyboard 
can be tuned to suit the user that it serves. 
 
4.2 Summary and moving on 
Although the majority of Windows software will have some keyboard short 
cuts, not all are standard.  The best approach is to look at the screen and try 
out a few things.  If we know that an underlined letter on a menu bar means 
that we can go straight to that menu by using the Alt key with that letter, look 
around for where they are.   When you get into a menu, take a look at the 
options in front of you and see if they suggest a keyboard short cut.  Press F1 
and see if it mentions short cuts in the help file. 
 
A list of keyboard shortcuts for Windows and other Microsoft products such as 
Word and Excel are available from the Microsoft website at 
www.microsoft.com/enable/products/keyboardassist.aspx 
 
The next step is creating your own shortcuts.  Most word processors enable 
you to use abbreviations.  By using a few letters you can produce repeated 
sentences quickly and easily.  An example: I use "ys" to produce "yours 
sincerely", with four blank lines and then my name for the end of my letters.  
Another area you can look at is Macros.  Check your help file or manual to 
see how to use them.  You can't break a computer by trying basic things in a 
word processor, so think about what you want to do and try things out! 
 
One experienced user who tried said, after a day or two, "It's amazing how 
quickly you will learn to use Windows without a mouse, if you just put the 
mouse away!"   Why not try it? 
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